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内容梗概

ソフトウェアの保守を困難にするものとしてコードクローンがあげられる．コードクロー

ンとは，ソースコード中に存在するコード片で同形のコード片が他に存在するもののこと

で，既存コードの「コピーとペースト」による再利用や，頻繁に用いられる同一処理により

プログラム中に作りこまれる．もし，複数のコードクローンを持つコード片にバグが見つ

かったなら，そのコードクローンすべてに同じ修正を行うかどうかを確認する必要がある．

しかし，すべてのコードクローンに対して，確認・修正を行うことはきわめて困難である．

我々の研究グループは，ソースコード中のコードクローンを検出するツール (CCFinder)

を開発してきている．CCFinderは，大規模ソフトウェアの保守・デバッグ作業の支援ある

いは教育環境におけるプログラム評価支援を目的としている．しかし，コードクローンの検

出結果はソースコードの行番号で提示されており，当然ながら，機能追加等のためにソース

コードを修正すると，コードクローン情報とソースコードとの間に行番号のずれが生じる．

したがって，複数箇所の修正（機能追加）を一度に行う場合には，その行番号のずれを意識

しながら作業しなければならず，作業効率が悪くなる．

本研究では，コードクローン検出ツール CCFinderで検出されたコードクローン情報を，

コメントとしてソースコード中に付加する手法の提案とツールの試作を行う．本ツールに

CCFinderの出力を与えることで，ソースコードにコードクローン情報が付加される．付加

されたコメントを利用することで，開発者は行番号のずれを意識せずに作業をすることがで

きる．実際に本ツールをあるソフトウェアプロジェクトの修正事例に対して適用した結果，

行番号のずれを意識せずに作業ができ，その有用性を確認した．

主な用語

コードクローン

ソフトウェア保守

デバッグ

コメント
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1 まえがき

ソフトウェア保守は，「納入後，ソフトウェア・プロダクトに対して加えられる，フォール

トの修正，性能またはその他の性質改善，変更された環境に対するプロダクトの適応のため

の改訂」と定義されている [14]．近年，ソフトウェアシステムの大規模化，複雑化に伴い，

プログラムの保守・デバッグ作業に要するコストが増加してきている．このため大企業では，

既存システムの保守に多くのコストを費やすようになり，保守作業の効率を高めることが，

ソフトウェア工学の重要な課題のひとつとなっている．ソフトウェア保守を困難にしている

要因の一つとしてコードクローンが指摘されている．

コードクローンとは，ソースコード中に存在するコード片で，同形のコード片が他に存在

するものである．それらは，既存システムに対する機能変更や拡張時における「コピーと

ペースト」による安易な機能的再利用の際に発生する．もし，あるコード片にバグが含まれ

ていた場合，そのコード片に対するコードクローンに対してもれなく，修正を行うか確認し

なければならない．また，保守性を高めるため，同値類を一つのサブルーチン等にまとめる

のがよい場合もある．そのためには，コードクローンをすべて検出することが必要となる．

これまでさまざまなコードクローン検出法が提案されている．我々の研究グループもトー

クン単位でのコードクローンを検出するツール (CCFinder[17]) を開発してきており，これ

までにさまざまなソフトウェアに対する適用を行った．これらの適用の中で，CCFinderは

大規模なソースコードも，細粒度でのコードクローン解析を非常に高速に行うことが可能で

あると評価されてきた．

一方，CCFinderを利用することで，ソースコード中からコードクローンを探す手間がな

くなったが，CCFinderのコードクローン情報は，ソフトウェアの規模が大きくなればなる

ほど，膨大なものとなり，必要な情報が埋没してしまうおそれがある．そこで我々は，有

効なクローン情報を抽出するために，CCFinderの解析結果の参照支援システムを試作し，

コードクローンの位置情報の視覚化と，コードクローンに対する単純的な評価尺度を用いて

ソースコードの参照支援を試みた．ところが，複数箇所の修正を一度に行う場合，機能追加

等でソースコードに修正を加える度に，コードクローン情報とソースコードとの間で行番号

のずれが生じる．開発者は，この行番号のずれを意識しながら修正箇所を特定するか，ある

いは一つの修正を終えるたびにコードクローンの位置情報を更新して修正箇所を見つけ出す

必要があった．これは作業効率の低下の原因となり，また修正箇所を間違える可能性を引き

起こしかねない．

そこで本研究では，ソフトウェア開発・保守の観点から，デバッグ・機能追加など，複数

箇所の変更を一度に行う際に，開発者が行番号のずれを意識せず他の修正箇所を発見するた

めの利用を目的とした，コードクローン情報をコメントとしてソースコードに付加する手法

4



の提案とツールの試作を行った．

実際には，まず，ソースコード中にコードクローンの位置情報をコメントとして付加する．

このコメントの付加はクローンごとに一意に振った IDを利用し，クローンに含まれるすべ

ての行に付加する．結果として，ソースコード上でのクローンの位置情報が行番号以外の方

法で表されているので，行番号のずれが生じても開発者はこれを意識することなく，クロー

ンの正しい位置を特定することができる．次に，ソースコード中で修正箇所を特定したとき

に，そこに付加されているコメントを利用して他の修正箇所を調べ修正を施す．この修正を

終えたら不要となったコメントを除去する．これらの作業を支援するため，試作したツール

には，コメント付加機能，一時ファイル編集機能，クローンクラス検索機能，コメント除去

機能，一時ファイル書き戻し機能を実装した．また，実際のソフトウェアを対象に適用実験

を行った結果，利用者が，行番号のずれを意識することなく，デバッグ作業を行うことがで

き，本手法の有用性を確認することができた．

以降， 2章では，ソフトウェア保守における問題やコードクローン検出に関連した研究に

ついて述べ， 3章で，コードクローン情報付加手法の提案を行う． 4章では，本ツールの

利用方針とその利点，そしてその実装についての説明を行う． 5章では，実際にソフトウェ

アを対象にして適用実験を行い，その結果と考察を行う．最後に 6章で，本研究のまとめと

今後の課題について述べる．
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2 コードクローン

2.1 コードクローンとソフトウェア保守

コードクローンとは，ソースコード中に存在するコード片で同形のコード片が他に存在す

るもののことで，いわゆる “重複したコード”のことである．

コードクローンがソフトウェア中に作りこまれる，若しくは発生する原因には次のような

ものがある．

既存コードのコピーとペーストによる再利用

近年のソフトウェアの設計手法を利用すれば，構造化や再利用可能な設計が可能であ

る．しかし，ゼロからコードを書くよりも既存のコードをコピーして部分的な変更を

加えるほうが信頼性が高いということもあり，実際には，コピーとペーストによる場

当たり的な既存コードの再利用が多く存在する．

コーディングスタイル

規則的に必要なコードはスタイルとして同じように記述される場合がある．例えば，

ユーザインターフェース処理を記述するコードなどである．

定型処理

定義上簡単で頻繁に用いられる処理，例えば，給与税の計算や，キューの挿入処理，

データ構造アクセス処理などである．

プログラミング言語の適切な機能の欠如

抽象データ型や，ローカル変数を用いられない場合には，同じようなアルゴリズムを

持った処理を繰り返し書かなくてはならないことがある．

パフォーマンス改善

リアルタイムシステムなど時間制約のあるシステムにおいて，インライン展開などの

機能が提供されていなければ，意図的に繰り返し書くことでパフォーマンスの改善を

図る場合がある．

コード生成ツールの生成コード

コード生成ツールにおいて，類似した処理を目的としたコードの生成には，識別子名

等の違いはあろうとも，あらかじめ決められたコードをベースにして自動的に生成さ

れるため，類似したコードが生成される．

偶然

単純に偶然一致してしまう場合もあるが，大きなコードクローンになる可能性は低い．
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もし，プログラムコード中にコードクローンが存在した場合には，一般的にコードの変更

等が困難であるといわれ，保守容易性低下の一因となっている．このようなコードクローン

による問題に対処する方法としては，以下の 2つが考えられる [15]．

コードクローン情報の文書化

コードクローンに関する情報が文書化され，断続的に保守されている場合には，コー

ドクローンに対する変更は幾分やさしくなる．しかし，すべてのコードクローンに対

する情報を常に最新に保つ作業は非常に手間がかかるため，現実的に困難である場合

が多い．

コードクローンの自動検出

コードクローンを形式的に定義し，コードクローンをプログラムテキスト中から自動

的に検出するためのさまざまな手法が提案され，検出システムが開発されてきている

[1][2][3][4][5][6][7][8][11][17][18][19][20][21].

それぞれの手法やツールの特徴を次節で述べる（我々の開発した CCFinderは 2.3節

参照）．

2.2 既存のコードクローン検出法

Covet

文献 [20]で定義された種々の特徴メトリクスのいくつかのメトリクス値を比較するこ

とによって，コードクローン検出を行う．検出対象言語は Javaである．

CloneDR[8]

抽象構文木 (AST)の節点を比較することによって，コードクローン（類似部分木）の

検出を行う．部分的に異なっているコードクローンも検出することが可能であり，検

出したコードクローンを自動的に等価なサブルーチンやマクロに置き換えることも可

能である．検出対象言語は，C/C++,COBOL,Java,Progressである．

Dup[2][3][4]

前処理として，ユーザ定義名のパラメータ化を行った後，行単位の比較によりコード

クローンを検出する．マッチングアルゴリズムには，サフィックス木探索 [13]を用い

ている．

Duploc[11]

前処理として，空白やコメント等を取り除いた後，行単位（のハッシュ値）での表検索

を用いた比較によってコードクローンを検出する．特徴は，言語に依存する処理をほ
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とんど行わないため，多くのプログラミング言語に対応することである．また，コー

ドクローンの散布図等のGUIを備えたツールであり，ソースコード参照支援を行う．

検出対象言語は，C,COBOL,Python,Smalltalkである．

JPlag[21]

ソースコードを字句解析し，トークン単位での比較を行う．プログラム盗用の検出を目

的として開発され，プログラム間の類似率を検出する．検出対象言語は，C/C++,Java

である．

Komondoorらの手法 [18]

関数等にまとめるのに適したコードクローンの抽出を目的として，プログラム依存グ

ラフ (PDG)上での各節点の比較を行うことでコードクローン（同型 (isomorphic)部

分グラフ）を検出する．文字列比較や抽象構文木等を用いた検出法では発見できなかっ

た非連続コードクローンや，対応行の番号が異なるクローン，互いに絡み合ったクロー

ン等を検出可能である．[18]で作成されたツールの検出対象言語は，Cである．

Krinkeの手法 [19]

ASTや TraditionalPDGに似た Fine-grainedPDGというグラフ上での類似 (similar)

部分グラフ（同型部分グラフではない）を検出することで，コードクローンが存在す

ると思しき場所を検出する．試作ツールの検出対象言語は，Cである．

SMC[5][6][7]

まず特徴メトリクスによってソースコードをコードクローンと思しきメソッドに絞り

込む．次に絞り込まれたメソッドのペアに対し，表検索を用いることでメソッド単位

のコードクローンを検出する．また検出されたペアのメソッドは，特徴により 18種類

に分類される．更にそれぞれの分類については共通のメソッドへの書き換え指針が示

されている．

MOSS[1]

検出アルゴリズムは公開されていない．JPlag同様，プログラム盗用の検出を目的とし

て開発された．検出対象言語は，Ada,C/C++,Java,Lisp,ML,Pascal,Sehemeである．

いずれの手法，ツールにおいても提案者によってコードクローンの定義が微妙に異なって

おり，検出されるコードクローンが異なっている．つまり，コードクローンの定義とは検出

アルゴリズムそのものによって定義される．Burdら [9]もCloneDR,Covet,JPlag,Moss，そ

して我々の開発したCCFinderを含めた 5つのツールを用いて，それぞれ検出されるコード
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Clone pair

Clone pair

Clone pair
Clone class

図 1: クローンペアとクローンクラス

クローンの比較を行っているが，すべての面において他のツールより優れているツールはな

く，使う場面に応じて，適切なツールを選ぶことが必要となってくると述べている．

2.3 コードクローン検出ツール CCFinder

2.3.1 概要

あるトークン列中に存在する 2つの部分トークン列α，βが等価であるとき，αはβのク

ローンであると定義する（その逆もクローンであるという）．また，(α，β)をクローンペ

ア (図 1参照)と呼ぶ．α，βそれぞれを真に包含するどのようなトークン列も等価でない

ときα，βを極大クローンという．また，クローンの同値類をクローンクラス (図 1参照)

と呼び，ソースコード中でのクローンを特にコードクローンと呼ぶ．

CCFinderは，単一または複数のファイルのソースコード中からすべての極大クローンを

検出し，それをクローンペアの位置情報として出力する．CCFinderのもつ主な特徴は次の

通りである．

細かい粒度のコードクローンを検出

字句解析を行うことにより，トークン単位でのコードクローンを検出する．

大規模ソフトウェアを実用的な時間とメモリで解析可能

例えば，10MLOCのソースコードを 68分（実行環境Pentium3 650MHz RAM 1GB）

で解析可能である [15]．

さまざまなプログラミング言語に対応可能

言語依存部分を取り替えることで，様々なプログラミング言語に対応できる．現在は，

C/C++,Java,COBOL/COBOLS,Fortran,Emacs Lispに対応している．またプレーン
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テキストに対しても，分かち書きされた文章として解析可能となっており，未対応の

言語に対しても完全一致判定によるコードクローンは検出することができる．

実用的に意味を持たないコードクローンを取り除く

• コードクローンは小さくなればなるほど偶然の一致の可能性が高くなるが，最小
一致トークン数を指定することができるため，そのようなコードクローンを検出

しないようにできる．

• モジュールの区切りを認識する．

ある程度の違いは吸収可能

• ソースコード中に含まれるユーザ定義名，定数をパラメータ化することで，その
違いを吸収できる．

• クラススコープや名前空間による複雑な名前の正規化を行うことで，その違いを
吸収できる．

• その他，テーブル初期化コード，可視性キーワード (protected,public,private等)，

コンパウンド・ブロックの中括弧表記等の違いも吸収することができる．

繰り返しコードに対して特別な処理を行う

例えば，コード列中で

X A B C A B C A B C A B C Y

のように 3つの記号 A,B,Cが繰り返していたとき，以下の “*”が付された部分を “繰

り返し”であると定義する．

X A B C A B *C *A *B *C *A *B *C Y

これは一見，

X A B C *A *B *C *A *B *C *A *B *C Y

のように定義する方が合理的であるように考えられる．しかしながら，この場合，も

しコードクローンとして検出されたコード片が B C Aであった場合，

X A [B C *A] [*B *C *A] [*B *C *A] *B *C Y
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のように，このコード列中から 3のコード片 (“[”,“[”で囲まれた部分)が，B C Aを各

要素とするクローンクラスに含まれる．すると，これら 3つの各コード片の非繰り返

しコードの長さは，左から順に 2,0,0と判定される．

一方，

X A B C A B *C *A *B *C *A *B *C Y

であれば，もしコードクローンとして検出されたコード片が B C Aであっても，

X A [B C A] [B *C *A] [*B *C *A] *B *C Y

となり，非繰り返しコードの長さは，左から順に 3,1,0と判定される．つまり，少なく

とも先頭のコード片に関しては，長さ 3と判定可能である．もちろんコードクローン

片の意味的な先頭になりうる記号が区別可能であれば，こういった問題は起こらない．

しかしながら，現実的には人間が見てもすぐにはコードクローン片の最初を判断しか

ねる場合もある．たとえば，

　　：

　代入文

　出力文

　代入文

　出力文

　　：

のようなコード列があった場合，2つ目の代入文は出力文の後始末をしているのか，次

の出力に備えた処理なのか判断は難しい．ゆえに，このような定義となっている．

2.3.2 コードクローン検出処理手順

CCFinderのコードクローン検出処理は，以下の 4ステップで構成されている．

ステップ 1：字句解析

ソースコードをプログラミング言語の文法に沿ってトークン列に変換する．その際，

空白とコメントは機能に影響しないので無視される．ファイルが複数の場合には，単

一ファイルの解析と同じように処理できるよう，単一のトークン列に連結する．

ステップ 2：変換処理

実用的に意味を持たないコードクローンを取り除くため，若しくはある程度の違いは
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吸収するためにトークン列を実用的に意味のあるコードクローンのみを検出するため

の変換を施す．例えば，変数名，関数名などはすべて同一のユニークなトークンに置

換される．

ステップ 3：検出処理

トークン列を比較して，一致した部分トークン列をコードクローンとする．ただし，

指定された最小一致トークン以上の長さを持つコードクローンのみが検出される．ま

た，トークン列の比較にはサフィックス木探索 [13]を行うため，線形時間で解析可能

となる．

ステップ 4：出力整形処理

検出されたクローンペアについて，元のソースコード上での位置情報を出力する．

2.3.3 検出例

実際に，CCFinderによってどのようなコードクローンが検出されるのか例を示す．図 2

には，Javaで互いに似通った 2つのメソッドが書かれ，左端には行番号が付されている．こ

こで，最小一致トークン数を 5トークンに定め，図 2のソースコードに対しコードクローン

検出を行うと，図 2中の A1（4行目-6行目）と A2（16行目-17行目），B1（8行目-10行

目）と B2（20行目-22行目），そしてC1（12行目）とC2（25行目）がそれぞれクローン

ペアとして検出される．それぞれのクローンペアの長さは順に 7，18，6トークンとなって

いる．見ての通り，A1とA2の間，B1と B2 の間には次のようないくらかの違いが含まれ

ているがコードクローンとして検出可能となっている．

• 名前空間の違い (e.g. “org.apache.regexp.RE”と “RE”).

• 変数名の違い (e.g. “pat”と “exp”).

• 改行とインデントの違い

• 中括弧表記の違い

これらの違いは，2.3.1節で述べた目的のため，CCFinderのトークン変換処理によって吸収

されている．

2.3.4 出力結果

本研究ではCCFinderからの出力結果を利用するため，実際に出力されてくる情報がどう

いったものか簡単に説明する．CCFinderの出力としては，クローンペアの出力と，クロー

ンクラスの出力があるが，本研究では後者を利用する．図 3にその出力例を示す．
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1. static void foo() throws RESyntaxException

2. {

3. String a[] = new String [] {"123,400", "abc"};

A1 4. org.apache.regexp.RE pat =

A1 5. new org.apache.regexp.RE("[0-9,]+");

A1 6. int sum = 0;

7. for (int i = 0; i < a.length; ++i)

B1 8. {

B1 9. if (pat.match(a[i])){

B1 10. sum += Sample.parseNumber(pat.getParen(0);}

11. }

C1 12. System.out.println("sum = " + sum);

13. }

14. static void goo(String [] a) throws RESyntaxException

15. {

A2 16. RE exp = new RE("[0-9,]+");

A2 17. int sum = 0;

18. int i = 0;

19. while (i< a.length)

B2 20. {

B2 21. if (exp.match(a[i]))

B2 22. sum += parseNumber(exp.getParen(0));

23. i++;

24. }

C2 25. System.out.println("sum = " + sum);

26. }

図 2: コードクローン検出例

#begin{file description}...#end{file description}
解析対象となったファイルパスのリスト．

ファイルパスの手前に来る 3つの数字は順に，「グループ・ファイル番号，行数，トー

クン数」である．入力の際，解析対象ファイル集合を 1階層のグループに分類するこ

とを可能にするため，グループ番号が存在する．

#begin{syntax error}...#end{syntax error}
言語文法を用いてトークン列に変換している際に発生した構文エラーの位置情報．

ここに書き出された行は，クローン検出の対象外となっている．

#begin{set}...#end{set}
ひとつのクローンクラスがこの間に含まれる．

コードフラグメントの内容は順に「グループ・ファイル番号，開始行番号・カラム番

号・トークン番号，終了行番号・カラム番号・トークン番号」である．
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#begin{file description}

0.0 1475 3429 /home/a/example1.c

0.1 3213 9669 /home/b/example2.c

:

#end{file description}

:

#begin{syntax error}

0.1 243,30

:

#end{syntax error}

:

#begin{clone}

#begin{set}

0.0 246,1,235 268,2,294

0.5 178,1,213 200,2,272

#end{set}

#begin{set}

0.0 1140,3,2342 1146,2,2378

0.16 143,5,279 149,2,315

0.26 197,5,415 203,2,451

0.55 59,3,29 65,2,65

#end{set}

:

#end{clone}

図 3: CCFinderの出力例　クローンクラス
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3 コードクローン情報付加手法

3.1 コードクローン情報の利用方法と問題点

我々は，開発者，保守者，管理者の 3者の観点から，次のようなコードクローンの分析・

利用目的があると考える．ここでいう管理者とは，ソフトウェアの開発保守プロセス全体を

管理，監視する者を指す．

開発者的観点

利用目的 1 プログラム記述ヘルプとしての利用

ある処理を記述している際，もしくはバグへの対処を行っている際に，その箇所

をサンプルコードや既存ソースコードと比較することにより，類似コード片から

処理方法のヒントやバグへの対応策を得られる可能性がある．

利用目的 2 デバッグへの利用

コードクローン検出をバグの位置の特定に直接利用するのは困難であると思われ

るが，，1箇所バグが見つかり，修正を行ったあと，同様の修正を行うべき箇所を

発見することには利用できる．

保守者的観点

利用目的 3 リファクタリングへの利用

リファクタリングとは “外部から見たときの振る舞いを保ちつつ，理解や修正が

簡単になるようにソフトウェアの内部構造を変化させること”であると定義され

ている [12]．このように，コードクローンになっている部分を 1つのメソッドや

関数にまとめることに利用できる．

利用目的 4 プログラムテキスト修正時のチェック

デバッグや，機能追加などにおける修正を行う際，同様の修正を行うべき箇所の

発見をすることができる．

管理者的観点

利用目的 5 設計品質評価への利用

対象ソフトウェアの中にどの程度類似しているものが存在するのかを全体的に確

認することで，類似モジュールが数多く存在するかどうか，設計品質が劣化して

いないかどうかを把握することで，設計の見直しの必要性を知ることができる．
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利用目的1,2,4 利用目的3 利用目的5

特定コード片に対する

コードクローンの抽出
リファクタリングに適した

コードクローンの抽出
ファイルの類似性

全体に対するコードクローン検出
部分的なコード

クローン検出

利用目的の決定

ソースコード参照

機能的なまとまりを

もったコードクローンの抽出，

メトリクス値による

コードクローンの抽出

クローン散布図を用いた

コードクローン位置の把握

類似度による

ファイルの抽出

修正・対応を行うかどうかの決定

コードクローン

情報検索ツール

CCFinder

Gemini

ステップ1

ステップ2

ステップ3

ステップ4

図 4: コードクローン情報利用プロセス

我々が考えるコードクローン情報利用プロセスは図 4にも示すように，次の 4つのステッ

プで構成される．

ステップ 1　利用目的の決定

上述した 5つの利用目的の中から選ぶ．これにより抽出すべきコードクローンが決定

する．

ステップ 2　コードクローン検出

CCFinderを用い，コードクローンを検出する．特定コード片に対するコードクローン

の抽出を行いたい場合は，そのコード片と分析対象ファイル群との間のコードクロー

ンを検出する．それ以外の場合は，分析対象のファイル内，および分析対象のファイ
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ル間のコードクローンを検出する．

ステップ 3　目的のコードクローンを探す

特定のコード片に対するコードクローンの抽出を行う場合は，これまでに “コードク

ローン情報検出ツール”が開発されており（[16]参照），利用者が指定したコード片に

対するコードクローン情報を得ることができる．それ以外の場合，リファクタリング

に適したコードクローンの抽出を行う場合に関しては，これまでに “Gemini”が開発

されており（[23][24]参照），機能的なまとまりをもったコードクローンの抽出および，

メトリクスを用いたコードクローンの抽出ができ，クローン散布図などを用いて抽出

されたコードクローン位置情報を確認し，ソースコードの参照を行える．

ステップ 4　修正・対応を行うかどうかの判断

ステップ 3で見つかったコードクローンが利用目的にあったものであるかを判断し，修

正等を行う．

問題点として，CCFinderで検出されたコードクローン情報は，ソースコード中での行番

号として提示されているため，上述のステップ 4の修正・対応で，ソースコードに修正を加

えるたびに，コードクローン情報とソースコードとの間に行番号のずれが生じてしまう．そ

のため，複数箇所の修正を続けて行う場合，開発者は次の対処法を行う必要がある．

対処法 　

検出されたコードクローン情報とソースコードの間で，行番号がずれていることを意

識しながら修正箇所を特定し，確認・修正を行う．

ところが，この対処法ではコードの追加・削除など，行数の増減を計算する必要などもあ

り，作業効率の低下が考えられ，更には，修正箇所を間違えるといった可能性もあると考え

られる．
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3.2 コードクローン情報付加手法

ここでは，3.1で述べた，行番号のずれを意識しながら作業することによって修正箇所を

間違えたり，作業効率が低下する問題点を解決するために，コードクローンの位置情報をコ

メントとしてソースコード中に付加する手法を提案する．こうすることで，ソースコード中

の行番号として示されたコードクローンの位置情報を，行番号以外の手段で提示することが

可能となり，開発者はプログラムの変更時に行番号のずれを意識せずに作業を行うことがで

きる．

手法の詳細は以下のようになる．

手順 1　コメントに利用する IDの決定

コードクローン検出ツールCCFinderから得られた解析結果をもとに，クローンクラ

ス毎に一意に IDを振る．IDは 1から始まる整数とする．

手順 2　コメントの付加

ソースコード中でクローンクラスに含まれるすべての行に，そのクローンクラスの ID

をコメントとして付加する．また，そのクローンクラスの先頭行のコメントに関して

は，IDの前後をソースコード中に現れないであろう文字列で挟んでおく．

本手法により，図 4に示したプロセスのステップ 4以降は以下のように修正される．

ステップ 4’　修正・機能追加

修正・機能追加すべき箇所を特定し，修正・機能追加を行う．

ステップ 5　コメント部のチェック

修正した箇所の前後の行に付加されているコメント（クローンクラスの ID）を調べ

る．それが修正箇所が属しているクローンクラスであるので，そのクローンクラスに

対して修正の検討を行うべきことがわかる．クローンクラスの IDをもとに，他の修

正・機能追加対象がどこに存在するかを調べる．エディタの検索機能でそのクローン

クラスの先頭位置を探し出す．

ステップ 6　コードクローンの修正・機能追加

修正・機能追加対象すべてに対して，変更が必要であるか検討し，必要であれば変更

する．

ステップ 7　不要コメントの除去

すべての箇所に対して，検討・変更を行った後，不要となったコメントを除去する．

18



4 コードクローン情報付加ツール

4.1 概要

3.2で提案した手法をもとに，コードクローン情報をソースコード中にコメントとして付

加するツールの試作を行う．

システム構成の概略図を図 5 に示す．ユーザは，GUI上から CCFinderの出力ファイル

を指定する．ツールはCCFinderの出力ファイルから，クローンの位置情報とファイル情報

を解析し，それをもとにファイルにコードクローン情報を付加していく．

4.2 機能設計

以降では，図 5 で示した各機能について説明する．

4.2.1 コメント追加機能

コメントを追加する際のコードクローン情報を得るため，GUI上から，ユーザに対して

入力としてCCFinderの出力ファイル（クローンクラスの出力）を求める．そのファイルか

ら，コードクローンの位置情報とファイル情報を取得し，それらをリストに登録する．

コメントの付加は，オリジナルのファイルに対してではなく，編集用に作成する一時的な

ファイルに対して行う．まず，カレントディレクトリ内に新しくディレクトリを作成し，そ

の中に，得られたファイル情報をもとに，ディレクトリ・ファイル階層を再現する．ファイ

ルの内容は，「オリジナルファイルのソースコード」＋「コードクローン情報のコメント」と

なっている．

コメントにはクローンクラスごとに一意に定めた IDを利用し，コメントはそのクラスの

先頭行から末尾行まですべての行に挿入する．こうすることによって，ソースコード上での

クローンの位置を行番号以外の方法で表すことになるため，コードクローン情報とソース

コードの間に行番号のずれが生じても正しい位置を示すことができる．実際にコメントを付

加した後のソースコードの様子は 4.4節の図 12を参照．

4.2.2 一時ファイル編集機能

コメントを追加した後の一時的なファイルを使ってプログラムを確認・編集するため，ファ

イル名を指定して，エディタを開く．エディタは，ユーザの使い慣れたものを利用できるよ

うに emacs,vi,geditなどから選択することができる．デフォルトの設定では emacsとなって

いる．
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図 5: システム概略図

4.2.3 コメント除去機能

あるクローンクラスに関する検討・修正を終えたとき，そのクローンクラスのコメントは

不要になる．このように不要となったコメントを除去する．除去する際には，クローンクラ

スごとに一意に定められた IDを指定するが，不要になったクローンクラスのコメントが複

数個ある場合も考えられるので，その場合は複数個の IDを指定する．こうすることで，コ

メントを付加したファイル群から，指定した IDを含むコードクローンに関するコメントを，

すべて除去する．

また，クローン情報に関するすべてのコメントが不要になった場合は，一括して除去する．

4.2.4 一時ファイル書き戻し機能

修正・機能追加のための編集用の一時的ファイル上で行った変更を，オリジナルのファイ

ル群に反映させるために，付加されたコメントをすべて除去したのち，オリジナルのファイ

ル群に上書きする．この際，上書きしたいファイルをユーザが指定する必要はなく，コメン

ト付加時にリストに登録しておいたファイル情報を利用する．
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A

B

図 6: ツール起動直後

4.2.5 クローンクラス検索機能

修正箇所を特定したとき，修正したいクローンが複数のファイルに分散していることもあ

る．この場合，コードクローン情報を参照する必要がある．この手間を省くため，修正して

いるクローンクラスがどのファイルに，何箇所含まれているかを知りたい．そこで，ユーザ

が指定したクローンクラスが含まれるファイル ID，ファイルパス，数を示す．ユーザは示

されたファイル，数すべてについて修正の検討を行う必要がある．

4.3 実装

本ツールは Javaを実装言語とし，JDK1.4を用いて実装を行った．コードサイズは約 1500

行となった．本ツールはC,Javaなどの言語に対応している．

本ツールを起動すると，図 6のような画面が表示される．図 6の Aで示されるのはメ

ニューバーで，ユーザはここから利用したい機能を選択することができる．また，図 6のB

で示されるステータスバーには，その状況に応じたメッセージが出力される．

以降，本システムの実装，及び使用方法について説明する．

4.3.1 コメント追加機能

メニューからRun→Append Commentを選択する．すると，図 7のような FileChooser

のフォームが表示されるので，CCFinderの出力ファイルを選択し，Runボタンを押すと，

選択した CCFinderの出力ファイルをもとにコメント追加が実行される．実行が終了する
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図 7: コメント追加機能選択時

と，ステータスバーに “Append Comment Complete”というメッセージが表示される．ま

た，追加した総ファイル数，総クローンクラス数も表示される．実行に失敗した場合には，

“fail”と表示される．

4.3.2 一時ファイル編集機能

メニューから File→ Openを選択する．すると，図 7と同様の FileChooserのフォーム

が表示されるので，エディタで開いて編集したいファイルを選択し，Openボタンを押すと，

エディタが起動する．エディタの選択は，メニューから Select Editorを選択し，利用した

いエディタのラジオボタンにチェックを入れる．デフォルトは emacsとする．

4.3.3 コメント除去機能

メニューから Edit→Delete Commentまたは，Remove All Commentsを選択する．

前者を選択すると図 8のようなフォームが表示されるので，除去したいコメントのクロー

ンクラス IDを入力する．複数除去したい場合は，数字をカンマで区切って入力する．Delete

ボタンを押すと，コメント除去が実行される．実行が終了すると，ステータスバーに “Delete

Complete”というメッセージが表示される．失敗した場合には，ステータスバーに “fail”と

メッセージが表示される．

後者を選択するとコードクローン情報に関係するすべてのコメントを除去する（もとから存

在したコメントは除去されない）．実行が終了すると，ステータスバーに “Remove complete”

というメッセージが表示される．失敗した場合には，“fail”と表示される．
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図 8: コメント除去機能選択時

図 9: 一時ファイル書き戻し機能選択時

4.3.4 一時ファイル書き戻し機能

メニューから File→OverWrite Original Fileを選択すると，図 9のように，本当に上書

きをするかどうかの確認を求めるダイアログが表示される．キャンセルする場合にはNOボ

タンを押す．上書きする場合には OKボタンを押すと，編集を行った一時的なファイル中

のコードクローン情報に関係するコメントをすべて除去したのち，オリジナルのファイル

に上書きする．この際，コメント追加時に登録しておいたファイル情報を元に上書きしてい

るので，ユーザがファイルを指定する必要はない．実行が完了すると，ステータスバーに

“OverWrite Complete”というメッセージが表示される．失敗した場合には，“fail”と表示さ

れる．

4.3.5 クローンクラス検索機能

メニューから Search→ SearchIDを選択すると，図 10のようなダイアログが表示される．

テキストフィールドに検索したいクローンクラスの IDを入力して，Searchボタンを押すと，

コードクローンの位置情報・ファイル情報から解析し，その結果を表として提示する．その

様子を図 11に示す．表には，ユーザが指定したクローンクラスを含むファイル ID，ファイ

ルパスと，そのファイルに指定したクラスのコード片が何箇所あるのかが表示される．
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図 10: クローンクラス検索

図 11: クローンクラス検索の結果

24



1: static struct descpack *

2: searchdesc(hin, tan, yom)

3: Wchar *hin, **tan, **yom;

4: { //@$544@

5: struct descpack *p, **pp, *next = (struct descpack *)0; //@544

6 Wchar *s; //@$538@,@544

7: int key = 0; //@538,@544

8: //@538,@544

9: for (s = hin ; *s ; s++) key += (int)*s; //@538,@544

10: key = ((unsigned)key & HINSHIBUFINDEXMASK); //@538,@544

11: for (pp = description + key ; p = *pp ; pp = &(p->next)) { //@538,@544

12: if (!Wscmp(p->hinshi, hin)) { //@538,@544

13: return p; //@538

14: } //@538

15: } //@538

16: return (struct descpack *)0;

17: }

図 12: コメント追加後のソースコードの一部

4.4 ツールの使用例

実際に本ツールを用いて，コメントを追加したソースコードを図 12に示し，その説明を

する．例えば，図 12の 4行目から 12行目は，544番目のクローンクラスに属しているとい

うことを示している．また，6行目から 15行目はクローンクラス 538に属している．この

例の場合，この関数中には 538，544という 2つのクローンクラスがあることになる．もし，

この関数中に修正箇所を発見したなら，この 538，544という 2つのクローンクラスに対し

て修正の検討を行う必要があると考えられる．
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5 適用実験

5.1 実験概要

オープンソース・ソフトウェア開発サイト SourceForge.jpにおいて開発されている日本語

入力システム「かんな」[10]で実際に行われたセキュリティ問題の修正履歴を用いた，擬似

的なデバッグを本システムの “修正への適用例”として行う．なお，「かんな」の開発言語は

C言語である．この擬似的なデバッグ作業に対して，本ツールを利用する場合としない場合

の作業過程を示し，本ツールの有用性を確認する．

5.2 修正データ

日本語入力システム「かんな」のバージョン 3.6と 3.6p1間でのセキュリティ問題の修正

において，バッファのオーバフローを検出するコードが挿入された．ソースコードのファイ

ル数及びサイズを表 1に示す．この修正は，全部で 3ファイル，30箇所に対して施されてい

るが，そのうちの 1ファイル，20箇所についてはバッファを仲介した処理を行っており，そ

の際に発生する可能性のあるオーバフローの検出を行うコードがこの修正によって追加され

た．また，この 20箇所では，変数名の一部が異なる変数に対してほぼ共通した処理を行っ

ている．

具体的には，追加するコード片の一例が，図 13に示すもので，このような追加処理を図 14

の 2405行目の直前に挿入するものとする（コードの左にある数字が行番号）．このとき，こ

の 1箇所に対するコードクローン全てに関して，同様の修正を行うかどうか検討し，必要な

らば修正を行うという作業をする．

5.3 作業過程の比較

本ツールを使わずに図 13で示されるコード片を図 14で示されるコード中 2405行目の直

前に挿入する場合を考える．他の修正箇所を見つける際ユーザはコードクローン情報を見て

探すことになる，このとき，2405行目に 2行のコード片を挿入したため，それ以降の行番

号は 2行ずつずれるが，図 15のようにコードクローン情報には 2行のずれは反映されてい

ない．

表 1: 処理対象データサイズ

コードサイズ 約 8万 8千行

ファイル数 92ファイル
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if (Request.type7.datalen != SIZEOFSHORT * 3)

return( -1 );

図 13: 追加コード片の一例

2399 static

2400 ProcWideReq7(buf)

2401 BYTE *buf ;

2402 {

2403 ir_debug( Dmsg(10, "ProcWideReq7 start!!\n") );

2404

2405 buf += HEADER_SIZE; Request.type7.context = S2TOS(buf);

2406 buf += SIZEOFSHORT; Request.type7.number = S2TOS(buf);

2407 buf += SIZEOFSHORT; Request.type7.yomilen = (short)S2TOS(buf);

2408 ir_debug( Dmsg(10, "req->context =%d\n", Request.type7.context) );

2409 ir_debug( Dmsg(10, "req->number =%d\n", Request.type7.number) );

2410 ir_debug( Dmsg(10, "req->yomilen =%d\n", Request.type7.yomilen) );

2411

2412 return( 0 ) ;

2413 }

2414

2415 static

2416 ProcWideReq8(buf)

2417 BYTE *buf ;

2418 {

2419 ir_debug( Dmsg(10, "ProcWideReq8 start!!\n") );

2420

2421 buf += HEADER_SIZE; Request.type8.context = S2TOS(buf);

2422 buf += SIZEOFSHORT; Request.type8.curbun = S2TOS(buf);

2423 buf += SIZEOFSHORT; Request.type8.curkouho = S2TOS(buf);

2424 buf += SIZEOFSHORT; Request.type8.size = S2TOS(buf);

2425 ir_debug( Dmsg(10, "req->context =%d\n", Request.type8.context) );

2426 ir_debug( Dmsg(10, "req->curbun =%d\n", Request.type8.curbun) );

2427 ir_debug( Dmsg(10, "req->curkouho =%d\n", Request.type8.curkouho) );

2428 ir_debug( Dmsg(10, "req->size =%d\n", Request.type8.size) );

2429

2430 return( 0 ) ;

2431 }

図 14: 修正箇所の典型的なコード片
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この行番号のずれへの対処法としては，次のものがある．

対処法 　

コードクローン情報とソースコードの間で，行番号がずれていることを意識しながら

修正箇所を特定し，確認・修正を行う．

この場合，残り 19箇所の修正を行っていくたびに，行番号のずれが生じる．そのような場

合に開発者が行の増減を覚えながら修正箇所を特定する作業するのは効率が悪い．更には，

修正箇所を間違えることも考えられる．実際にこの 20箇所の修正において，合計で 101行

追加されていることが確認されている点から考えても，このことは明らかである．

これに比べて，本ツールを利用してコメントの追加を行った場合を考える．ソースコード

は図 16のようになっている．このとき，修正処理を追加した 2405，2406行目をはさむ前

後の数行には，クローンクラス 1311，1318のコメントが書かれているのがわかる．つまり，

この箇所はクローンクラス 1311と 1318に含まれていたこととなり，これらのクラスのコー

ド片に対して同様の修正を行うかどうかの検討を行えばよいと判断できる．実際に図 16中

の 1311のコメントが付加されている 2422行目にも同様の修正を行う必要があることが確認

できた．

この修正作業を行うには，クローンクラス検索機能を利用してクローンクラス 1311と 1318

がどのファイルにいくつ含まれているかを調べる．そして，そのファイルをファイルオープ

ン機能で開き，ファイルの検索機能，grepなどの検索システムで，例えば，“@$1311@”と

いうようにコメント中のクローンクラス IDを利用して，そのクローンクラスの先頭位置を

探して修正を行っていけばよい．

以上の作業の間，行番号のずれを意識する必要はまったくなかったことがわかる．

このことより，複数箇所の修正を行う場合において，本ツールの利用は作業の効率化，正

確化を考える上で非常に有用であることがわかる．

5.4 実行時性能の評価

このソースコードに対してコメント追加，全消去，一時ファイル書き戻し，及びクローン

クラス検索にかかった処理時間を表 2に示す．実行環境は，CPUはPentium4 2.0GHz，主

記憶容量は 512MB，OSは FreeBSDである．また，CCFinderの最小一致トークン数は 30

トークンに設定した．

5.5 クローン検出率

本ツールでは，ある特定のコード片に対するコードクローンを探して検討・修正するとい

う情報検索的な利用を行う点から，f値 [22]による評価も行う．f値とは完全性と効率性か
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#begin{set} 　←　クローンクラス 1311

0.91 2367,1,7452 2375,24,7483

0.91 2383,1,7519 2391,24,7550

0.91 2399,1,7586 2407,24,7617

0.91 2415,1,7657 2423,24,7688 ←←　これ以降の行番号は全て 2 行分ずれている
0.91 2433,1,7739 2441,24,7770

0.91 2587,1,8410 2595,24,8441

0.91 2640,1,8619 2648,22,8650

0.91 2657,1,8694 2665,24,8725

#end{set}

:

#begin{set} 　←　クローンクラス 1317

0.91 2376,5,7488 2381,2,7518

0.91 2392,5,7555 2397,2,7585

0.91 2408,5,7626 2413,2,7656 ←←　これ以降の行番号は全て 2 行分ずれている
0.91 2426,5,7708 2431,2,7738

0.91 2444,5,7790 2449,2,7820

0.91 2554,5,8276 2559,2,8306

0.91 2650,5,8663 2655,2,8693

#end{set}

#begin{set} 　←　クローンクラス 1318

0.91 2399,1,7586 2407,50,7619

0.91 2587,1,8410 2595,51,8443 ←←　これ以降の行番号は全て 2 行分ずれている
0.91 2657,1,8694 2665,51,8727

#end{set}

図 15: コードクローン情報
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2399 static //@$1311@,@$1318@

2400 ProcWideReq7(buf) //@1311,@1318

2401 BYTE *buf ; //@$1311,@1318

2402 { //@1311,@1318

2403 ir_debug( Dmsg(10, "ProcWideReq7 start!!\n") ); //@1311,@1318

2404 //@1311,@1318

2405 if (Request.type7.datalen != SIZEOFSHORT * 3)

2406 return( -1 );

2407 buf += HEADER_SIZE; Request.type7.context = S2TOS(buf); //@1311,@1318

2408 buf += SIZEOFSHORT; Request.type7.number = S2TOS(buf); //@1311,@1318

2409 buf += SIZEOFSHORT; Request.type7.yomilen = (short)S2TOS(buf); //@1311,@1318

2410 ir_debug( Dmsg(10, "req->context =%d\n", Request.type7.context) ); //@$1317@

2411 ir_debug( Dmsg(10, "req->number =%d\n", Request.type7.number) ); //@1317

2412 ir_debug( Dmsg(10, "req->yomilen =%d\n", Request.type7.yomilen) ); //@1317

2413 //@1317

2414 return( 0 ) ; //@1317

2415 } //@1317

2416

2417 static //@$1311@,@$1312@,@$1319@,@$1320@

2418 ProcWideReq8(buf) //@1311,@1312,@1319,@1320

2419 BYTE *buf ; //@1311,@1312,@1319,@1320

2420 { //@1311,@1312,@1319,@1320

2421 ir_debug( Dmsg(10, "ProcWideReq8 start!!\n") );

//@$1307@,@1311,@1312,@1319,@1320

2422 //@1307,@1311,@1312,@1319,@1320

2423 buf += HEADER_SIZE; Request.type8.context = S2TOS(buf);

　　　　　　　　　　　　　　　　　　　//@1307,@1311,@1312,@1319,@1320

2424 buf += SIZEOFSHORT; Request.type8.curbun = S2TOS(buf);

　　　　　　　　　　　　　　　　　　　//@1307,@1311,@1312,@$1315@,@$1316@,@1319,@1320

2425 buf += SIZEOFSHORT; Request.type8.curkouho = S2TOS(buf);

　　　　　　　　　　　　　　　　　　　//@$1304@,@1307,@1311,@1312,@1315,@1316,@1319,@1320

2426 buf += SIZEOFSHORT; Request.type8.size = S2TOS(buf);

　　　　　　　　　　　　　　　　　　　//@$1304@,@1307,@1315,@1316,@1319,@1320

2427 ir_debug( Dmsg(10, "req->context =%d\n", Request.type8.context) );

　　　　　　　　　　　　　　　　　　　//@$1304@,@$1308@,@1315,@1316,@1320

2428 ir_debug( Dmsg(10, "req->curbun =%d\n", Request.type8.curbun) );

　　　　　　　　　　　　　　　　　　　//@$1304@,@1308,@1315,@1316,@$1317@,@1320

2429 ir_debug( Dmsg(10, "req->curkouho =%d\n", Request.type8.curkouho) );

　　　　　　　　　　　　　　　　　　　//@1308,@1315,@1316,@1317,@1320

2430 ir_debug( Dmsg(10, "req->size =%d\n", Request.type8.size) );

　　　　　　　　　　　　　　　　　　　//@1308,@1317,@1320

2431 //@1317,@1320

2432 return( 0 ) ; //@1317,@1320

2433 } //@1317,@1320

図 16: 修正後のコード片
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ら検索結果の精度を評価するもので，

f 値 =
2 ×完全性×効率性
完全性+効率性

で求められ，その値が大きいほど情報検索の精度が高いとされる．また，ここで

完全性: 修正が必要な箇所のうち実際に検出された割合

効率性: 検出されたうち実際に修正箇所である割合

と定義する．ここでいう “検出された”とは，“ある修正箇所を特定したときに，その箇所に

あるコメント内のクローンクラスの IDをたどって，たどり着ける箇所”とする．

これらの定義を用いて検出された修正箇所の数，f値を計算した．比較対照として標準的

な検索システムである grepをあげる．grep検索の引数には，バッファ処理時に使われる変

数名の共通部分である “Request.type”を用いた．結果は表 3に示すとおりである．

結果から，本システムの検出した修正箇所を用いた場合，修正しない箇所を検出しないた

め，grepによる検索よりも f値は大きくなっており精度が高いといえる．また，grepなど

の検出システムでは，ユーザが明示的に検索対象のコード片を指定する必要があり，結果が

ユーザの能力に依存すると考えられるが，本システムでは指定する必要がないので，そのよ

うな心配は必要ないと期待される．本システムで，完全性を向上させるためには，CCFinder

の最小一致トークン数を下げて検出するクローンの数を増やせばよいが，それに伴い，偶然

の一致によるクローンなど，修正しない箇所も検出されるため効率性が低下することが考え

られる．さらに，本ツールにより付加されるコメントの数が増加し，ソースコードが見づら

くなることが考えられる．実際に本適用例においてCCFinderの最小一致トークン数を変化

させたときの結果を表 4に示す．本実験では，CCFinderの最小一致トークン数はデフォル

トの 30に設定したが，この結果を見れば 20トークンにしたときが f値が最高になることが

わかる．しかし，最小一致トークン数はCCFinderを実行する最初の段階で設定しなければ

ならないため，実際には，対象とするソフトウェアの性質などから，よい結果が得られそう

な最小一致トークン数を設定するしかない．

表 2: 処理時間

コメント追加 約 5秒

コメント全消去 約 3秒

ファイル上書き 約 3秒

クローンクラス検索 1秒未満
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表 3: 検出結果と f値

　 grep 本ツール

総修正箇所 20箇所 20箇所

全検出箇所 61箇所 20箇所

検出された修正箇所 19箇所 15箇所

完全性 95％ 75％

効率性 31％ 100％

f値 0.50 0.86

表 4: 最小一致トークン数の変化

トークン数 50 40 30 20 10

完全性 13％ 16.5％ 75％ 90％ 100％

効率性 100％ 100％ 100％ 100％ 5％未満

f値 0.23 0.28 0.86 0.95 0.1未満

コメント数 0.5個 1個 4個 11個 30個

32



6 まとめと今後の課題

本研究では開発・保守工程において，複数箇所のプログラム修正作業を支援することを目

的として，コードクローン検出ツールCCFinderを利用したコードクローン情報付加手法の

提案とツールの試作を行った．

本研究は，あるコード片に対して修正を行ったあと，類似した他のコードに対する検討・

修正を効率的に行うことを目的としている．コードクローン情報をコメントとしてソース

コード中に付加することで，修正時に起こるコードクローン情報とソースコード間での行番

号のずれを意識せずに作業することができる．

更に，本ツールを日本語入力システム「かんな」の開発において実際に行われたバージョ

ンアップの修正を用いて擬似的なデバッグを行い，その有用性を確認した．

今後の課題としては，

• 利用者の使い慣れたエディタへの対応など，実用性の向上

• さまざまなプログラミング言語への対応

• 本ツールを利用したことによってプログラムの変更がどれだけ容易になったかの定量
的，客観的な評価

• 実際のソフトウェア開発・保守現場での適用実験と評価

が考えられる．
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